DEVELOPMENT AND UTILIZATION
OF AN EVALUATION PROCESS
FOR TRAFFIC SIGNAL CONTROL SYSTEMS

Final Report
KLK212
N06-11

National Institute for Advanced Transportation Technology
University of Idaho

November 2006

AHMED ABDEL-RAHIM; MICHAEL DIXON, AND MIN LUO
DISCLAIMER

The contents of this report reflect the views of the authors, who are responsible for the facts and the accuracy of the information presented herein. This document is disseminated under the sponsorship of the Department of Transportation, University Transportation Centers Program, in the interest of information exchange. The U.S. Government assumes no liability for the contents or use thereof.
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Title and Subtitle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Report Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>September 2006</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Performing Organization Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KLK212</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Author(s)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ahmed Abdel-Rahim; Michael Dixon; and Min Luo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N06-11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Performing Organization Name and Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>National Institute for Advanced Transportation Technology University of Idaho PO Box 440901; 115 Engineering Physics Building Moscow, ID 838440901</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Work Unit No. (TRAIS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Contract or Grant No.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DTRS98-G-0027</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Sponsoring Agency Name and Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>US Department of Transportation Research and Special Programs Administration 400 7th Street SW Washington, DC 20509-0001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. Type of Report and Period Covered</td>
<td></td>
<td></td>
</tr>
<tr>
<td>August 2002--September 2004</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USDOT/RSPA/DIR-1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Supplementary Notes:**

16. Abstract
Evaluating traffic control systems using hardware-in-the-loop simulations (HILS) can be labor intensive. To facilitate this process, tools have been developed for utilizing HILS efficiently and effectively. A Windows-based software was developed to seamlessly execute batch runs, extract user specified output data in a useful format, and monitor time lags in controller and simulation operations. Statistical techniques, using the output data were identified and tailored to the evaluation of traffic control systems across time and space. To ensure that HILS is applied appropriately, HILS application guidelines were identified to aid users in determining when HILS should be employed to evaluate a traffic control system. Program documentation and case studies are included to aid traffic engineers, transportation professionals, undergraduate students, and graduate students.

17. Key Words
Traffic control systems; evaluation; simulation; laboratories

18. Distribution Statement
Unrestricted; Document is available to the public through the National Technical Information Service; Springfield, VT.

| Unclassified | Unclassified | 111 | ... |

Form DOT F 1700.7 (8-72) Reproduction of completed page authorized
**TABLE OF CONTENTS**

ABSTRACT ........................................................................................................................3

1. INTRODUCTION .......................................................................................................... 4

2. METHODOLOGY ......................................................................................................... 5

3. CORSIM OUTPUT PROCESSOR DESIGN DOCUMENT ........................................... 7
   3.1 INTRODUCTION ................................................................................................... 7
   3.2 USING VISUAL STUDIO TO WORK ON COP .................................................... 7
   3.3 NOTES ABOUT USING CORSIM OUTPUT PROCESSOR .................................. 7
   3.4 CORSIM OUTPUT PROCESSOR FILES (VISUAL BASIC .NET) ....................... 8
      3.4.1 MainForm.vb .................................................................................................. 8
      3.4.2 VehTrkForm.vb ........................................................................................... 12
      3.4.3 GreenTimeForm.vb ...................................................................................... 13
   3.5 NIATT CORSIM DLL Files(C) ........................................................................... 13
   3.6 INSTALL CORSIM OUTPUT PROCESSOR V1.1 ......................................... 14

4. INSTRUCTIONS FOR CASE STUDIES: TRAFFIC CONTROLLER LABORATORY II .............................................................. 15
   4.1 INSTRUCTIONS .................................................................................................. 15
   4.2 CASE STUDIES .................................................................................................. 16
      CASE 1: Run simulation (without HILS) for one intersection with CORSIM .... 16
      CASE 2: Run HILS for One Intersection with CORSIM and Aries .................. 19
      CASE 3: Run HILS for Three Intersections (Time-Based Coordinated System) with CORSIM and Aries ............................................................... 33
      CASE 4: Run HILS for Three Intersections (Master-Based Coordinated System) with CORSIM and Aries ............................................................... 47
      CASE 5: Run Simulation (without HILS) for One Intersection with VISSIM ... 61
      CASE 6: Run HILS for One Intersection with VISSIM and Aries .................... 63
      CASE 7 Set Up Master-Based Coordinated Subsystems for Twenty intersections with Aries ............................................................... 82
ABSTRACT

Evaluating traffic control systems using hardware-in-the-loop simulations (HILS) can be labor intensive. To facilitate this process, tools have been developed for utilizing HILS efficiently and effectively. A Windows-based software was developed to seamlessly execute batch runs, extract user specified output data in a useful format, and monitor time lags in controller and simulation operations. Statistical techniques, using the output data were identified and tailored to the evaluation of traffic control systems across time and space. To ensure that HILS is applied appropriately, HILS application guidelines were identified to aid users in determining when HILS should be employed to evaluate a traffic control system. Program documentation and case studies are included to aid traffic engineers, transportation professionals, undergraduate students, and graduate students.
1. INTRODUCTION

This National Institute of Advanced Transportation Technology (NIATT) publication accomplishes three tasks:

1) Develops the process and tools to systematically evaluate a range of traffic control systems using hardware-in-the-loop simulation (HILS);
2) Identifies conditions under which HILS should be applied to evaluate traffic signal control systems; and,
3) Develops an appreciation and understanding of the different traffic control systems in undergraduate students, graduate students, and transportation professionals through systematic lab tests and case studies.

These tasks provide the following benefits to the transportation engineering and planning communities:

- Evaluation of traffic control systems will be made more efficient and statistically valid through the use of the software and statistical tools developed.
- Appropriate applications of HILS are more fully explored resulting in the correct implementation of HILS to the evaluation of traffic signal control systems.
- Traffic engineers will be able to make more informed decisions regarding different types of traffic signal control systems. This could result in significant savings for instances where a less advanced system is evaluated and determined to be just as effective as a more advanced and more costly system.
- The knowledge level of how to evaluate traffic signal control systems using HILS is increased as a result of the program documentation and case studies.
- This research will be applicable not only to metropolitan areas, but also to medium and small-sized cities in Idaho and the nation.

These benefits are the result of research funded by the NIATT at the University of Idaho. They represent NIATT’s strong commitment to education and research by combining advanced, cutting-edge, research with training for undergraduate and graduate students. It also represents the other NIATT commitment to outreach and technology transfer by providing for local, state, and national uses and allows small to medium-sized cities to have a larger capacity for transportation engineering and planning.
2. METHODOLOGY

The research documented in this report utilized the following methodology:

1) Plan and implement a prototype expansion to NIATT’s traffic controller lab. This will involve the set up of five 2070 controllers, including the required software, and the successful execution of the following types of traffic signal control systems:
   a. Isolated-fixed time
   b. Isolated-actuated
   c. Coordinated-fixed time
   d. Coordinated-master based
   e. Coordinated-closed loop

2) Identify traffic volume conditions and signal control conditions (system configurations, controller types, phasing plans, other controller parameters) under which HILS should be applied to evaluate traffic signal control systems. This will result in a formal set of HILS application guidelines.

3) Develop windows based software designed to facilitate the evaluation of different traffic control systems. The primary functions of the software will be the following:
   a. execute batch runs using HILS,
   b. extract user defined output from simulation output files in an easily used format,
   c. detect and report time lags between simulation and controller operations.

4) Develop a process using the software developed in item 3 (above) whereby traffic control systems can be rigorously and consistently tested. The process will include the following:
   a. Effective performance measures for evaluating the full range of traffic control systems.
   b. Techniques for determining the statistical significance of differences in traffic operations over time and space. It may be that a simple t-test of overall performance is sufficient. However, a more detailed comparison may be necessary in which case more powerful statistical methods might be needed.
   c. Testing strategies that will encompass the strengths and weaknesses of the systems being evaluated.

5) Evaluate a fixed time coordinated system, a master controller based actuated coordinated system, and two closed loop coordinated systems. This will have two outcomes: 1) an increased knowledge of the quality of operations that these systems can achieve relative to a base case of fixed time coordination and 2) a
greater understanding of how these systems should be tested in the laboratory using HILS.

6) Develop and beta test training materials for undergraduate courses, graduate courses and workshops to evaluate traffic control systems. Emphasis will be given to different forms of coordinated systems.
3. CORSIM OUTPUT PROCESSOR DESIGN DOCUMENT

3.1 INTRODUCTION

This manual explains how the CORSIM Output Processor program was implemented to facilitate future code maintenance and leveragability. The descriptions provide an overview of how each design element works and where it fits into the overall flow. Because of the scope of this project and time constraints, most of the discussion of the code is fairly high-level. Reading this manual will give a developer a starting point for understanding code details by looking at the code itself. One good way to learn what the program does is by using the program itself.

3.2 USING VISUAL STUDIO TO WORK ON COP

The project file for the CORSIM output processor is:

CORSIM Output Processor v1.1.vbproj
This file points to two different projects: one in Visual Basic .NET for the GUI:
CORSIM Output Processor v1.1.sln,
and the other in C for the raw data processing:
NIATT CORSIM DLL.sln

The project for the installer is separate:
Install CORSIM Output Processor v1.1.vdproj (vdproj is not misspelled)

3.3 NOTES ABOUT USING CORSIM OUTPUT PROCESSOR

Since this manual is for developers rather than end-users, instructions for using the template for analysis are not a primary focus. However, some helpful tips for using this program have been included here since a separate Users’ Manual is not planned. For further questions about using CORSIM Output Processor, please contact Dr. Michael Dixon at mdixon@uidaho.edu or Dr. Ahmed Abdel-Rahim at ahmed@uidaho.edu .

Note: CORSIM Output Processor requires Microsoft Office 2003.
3.4 CORSIM OUTPUT PROCESSOR FILES (VISUAL BASIC .NET)

The code in these files was developed by copying and improving a previous version of the CORSIM Output Processor. That version had zero documentation, which added a great deal of development time for the improvements. This Design Document is meant to alleviate some of the problems that lack of documentation caused during the last design iteration. However, nothing is perfect and unfortunately time considerations must make this document shorter than it should be. Hopefully it will give a skeleton view of how the Visual Basic files are structured so that debugging efforts or improvements can be targeted toward a narrower section of code.

3.4.1 MainForm.vb

This form contains tabs for each of the main functions of the program. The Graph tab has not been implemented yet. The Single-Run Vehicle Data tab and the Green Times tab are deprecated because their functionalities have been incorporated into the Process One File and Process Multiple Files tabs. However, they have left them as simpler examples for the next developer to study since they are easier to follow.

Each tab has a certain abbreviation associated with all of the objects and methods it uses.

- The Single-Run Vehicle Data tab uses SR.
- The Green Times tab uses GT.
- The Process One File tab uses the abbreviate MR, which used to stand for Multi-Run (as opposed to Single-Run)
- The Process Multiples File tab uses AR, which used to stand for Auto Run, since multiple files are being run automatically.
- The Unique Paths tab uses UP
- The Graph tab does not contain any objects or methods (yet).

Note: the developer never needs to look inside the region titled: Windows Form Designer generated Code. This stuff is taken care of by Visual Studio and does not need tweaking. Initializations should be put in the MainForm_Load() method.

Most important functions are found in the Non-event routines section at the beginning of the file. Many of these functions have been overloaded to do more complicated things
than they originally were designed for. Unfortunately, this makes the code a little complicated.

3.4.1.1. Important Globals

Most of the global variables in the MainForm are fairly self-explanatory. Here are some helpful notes:

- At the beginning of the Declarations section, the API calls to the NIATT CORSIM DLL C functions are declared.
- vehTrkRan is a variable that keeps track of whether or not the processVechMessages() function has already been run, this is used in several places to see if the output data from that function are already available or whether they need to be generated.
- The numGreenTimeForms and numVehTrkForms variables are used to make sure that the data files on disk that are underneath the table windows get unique filenames even when multiple table windows are open. The variables increment each time a new window of the respective type is created. Then that number is put on the end of the filename associated with that window. Of course, when the windows are closed, these files are deleted automatically, so they don’t clog up the hard drive.
- The actuatedSigs and nodeNum arrays are declared empty, then they are extended when a new tsd file is opened. Visual Basic .NET allows the length of arrays to be extended after they are declared.

3.4.1.2 MainForm_Load()

This method performs initializations of global variables when the program first launches. One important thing it does is hide the Single Run Vehicle Data and Green Time tabs, since they are deprecated and for developer learning only. It also sets up the log file.

3.4.1.3 btnMRVehData_Click()

This method runs when the user clicks the Vehicle Data button on the Process One File tab. This method initiates processing of the raw CORSIM data according to the detector rules set by the user on the tab. It first checks to see if the user has correctly configured the save and display options for the results. If the user wants to save the results, it makes sure that a filename and or path have been entered in the correct place. Then it starts reading in the detector rules from the text box. If all of the necessary information for a detector has been specified--Downstream Node, Upstream Node, and position--then it calls makeVehTrk to continue processing. Otherwise, it keeps a tally of the number of
entries that could not be processed and prints an error message at the end. If the user has specified that all of the detector results should be saved as individual sheets in a single Excel workbook, then this method creates new workbook, deletes all but one of the sheets (it can’t delete the last one yet), passes that workbook to makeVehTrk each time to add the new sheet, then at the end deletes last original sheet so that only Vehicle Tracking sheets are left in the Excel workbook. This function uses a WaitForm to display its progress to the user.

3.4.1.4 makeVehTrk()

This method is responsible for calling the NIATT CORSIM DLL function to process the data, then building a form with the resulting data in a table, then saving that data if necessary in a variety of formats. It is very overloaded with optional parameters which handle all of the different auto-saving possibilities. After checking the validity of the inputs, the first task of this method is to run processVechMessages() to get the raw output data. Then it declares a new form (window) for the Vehicle Tracking data and populates it with the raw output data. Then, as specified, it autosaves the processed data as an Excel file or text document.

3.4.1.5 btnMRGreenTimes_Click()

This functions similarly to btnMRVehData_Click() except it creates Green Times forms for the Upstream Nodes listed in the text box, rather than processing detectors. It calls makeGreenTime() to do the actual Green Time form creation. This function uses a WaitForm to display progress to the user.

3.4.1.6 makeGreenTime()

This method has all the same options as the makeVehTrk method with respect to the auto-saving possibilities. It can save the result tables as individual Excel files, sheets in a single Excel file, or as text files. It calls processSignalMessages() for whatever list of signals it thinks it is supposed to do. When it is called from the Process One File or Process Multiple Files tabs, it receives one signal at a time to do. However, this function was originally designed to work with the Green Times tab, on which the user simply
highlighted the signal numbers that he wanted Green Times for. Thus, when the optional signal parameter to this method is the default value of -1, which is not a valid signal number, then the function assumes it is supposed to run for the list of signals highlighted on the Green Times form. After calling processSignalMessages, makeGreenTime() declares a new Green Time window and fills it with the output data. Then it does any auto-saving required.

3.4.1.7 mnuFileOpen_Click()

This function is called when the user chooses File >> Open on the toolbar. It closes the old files, then gets the new file from the user through a dialog, then calls fillSignalLists() to open the new files and load the basic information, like signal lists and relationships between signals.

3.4.1.8 fillSignalLists()

This function reads the .trf file from the CORSIM simulation to determine the identifiers of the signals and what type of signals they are. It looks for lines that end with 43 or 35. These lines identify a certain signal (intersection) by number and also identify the numbers of the signals upstream from it in all directions. The numbers must be read in as strings, then converted to integers. The spacing in the .trf file is fixed, so the same character offsets work for every line. The signal information is stored in the actuatedSigs array and in three lst**SignalList listboxes on the three different tabs: Process One File (MR), Single Run Vehicle Data (SR) and Green Times (GT). As noted before, only the Process One File tab is visible in this version.

3.4.1.9 btnARVehData_Click()

This method runs when the Vehicle Data button on the Process Multiple Files tab is pressed. The purpose of the Process Multiple Files tab is to run the same detectors (or green times) on a batch of similar CORSIM simulation results. As such, this function opens all of the simulation files in an entire directory, one at a time, and runs the set of detectors against each simulation just like the Process One File tab would. This function uses the Wait2Form to display progress to the user. Basically, btnARVehData_Click() is
just like btnMRVehData_Click() (see above) except instead of only working with one file, it loops through several files. Likewise, the btnARGreenTimes_Click() method is similar to btnMRGreenTimes_Click.

3.4.1.10 tnUPUniquePaths_Click()

This method calls the travelStats() function in the NIATT CORSIM DLL library to find the set of unique paths between the two specified nodes. It then loads the result file into the text box on the Unique Paths tab. This feature is probably not working very well.

3.4.2 VehTrkForm.vb

3.4.2.1 New()

This function takes the source data filename as a parameter as well as the link identifier. It stores these pieces of information in variables within the form, so that methods of the VehTrkForm can access them later.

3.4.2.2 fillVehTrkForm()

This function reads in the table from the output file generated by the NIATT CORSIM DLL processVechMessages() function. It has to skip rows that begin with * because these rows do not contain important data. Each line in the data file is translated into a row in the table. The lines are comma-delimited, so the algorithm reads one character at a time until it reaches a comma, then inserts the token into the next available cell in the table. This function also does some formatting stuff to make the table in the window look better. At the very end, after all of the information has been loaded into the table, saveAsText is called to generate the plain-text version of the table, and the result of saveAsText is loaded into the rtf box, so that the user can choose View >> Text to view the table as plain-text.

3.4.2.3 saveAsExcel()

This function opens the destination Microsoft Excel file and gets the oCells object for the appropriate sheet, then calls DumpData to transfer the data in the table to the Excel sheet.
3.4.2.4 DumpData()

This function uses the properties of the DataTable object that stores the table in the window. The DataTable is composed of DataRows, which each have a member called ItemArray which contains the values of that row as an array of objects. Then it is very simple to transfer each value from the table row to the spreadsheet row.

3.4.3 GreenTimeForm.vb

3.4.3.1 fillGreenTimeForm4()

Getting the Green Times to appear in a useful format was fairly difficult, therefore about 4 different table formats were used. The other three methods are still present in the code, if anyone wants to change the makeGreenTime function to use one of them instead of fillGreenTimeForm4. This function was designed to display the Green Times in a format similar to what the NIATT team was already using in other research areas. This format has a single column for each signal. In that column, the times cycle through the progression Green On, Green Off, Red On, Red Off. In a second column, the Left On and Left Off times are displayed next to the Green on and Green Off times. This method reads the input file, which is organized by signal and color (e.g. Red on, Left Green Off…). When a new link is encountered, a new column is started because that link has a completely separate set of Green Times. The number of rows in the table must be maintained because it is possible that a later signal will have more transitions, and therefore require more rows, than the first signal.

3.4.3.2 Others

The GreenTimeForm has saveAsExcel and saveAsText methods similar to the VehTrkForm.

3.5 NIATT CORSIM DLL Files(C)

These files were developed by Andrew Huska before the Output Processor GUI was created. They seem to just work, which is good because they are not well understood. The
only functions which are used by the CORSIM Output Processor directly are processVechMessage(), processSignalMessages(), and travelStats().

3.6 INSTALL CORSIM OUTPUT PROCESSOR V1.1

This is a separate project, which points to the CORSIM Output Processor v1.1 project. This project describes the files that the installation needs to copy and register with the operating system. In the Application/bin directory, there is the CORSIM Output Processor v1.1.exe file. The path to this file is the path on my local computer, a new user will have to update the path for the source files. The easiest way to do this is the delete the CORSIM Output Processor v1.1.exe file and the NIATT CORSIM DLL.dll file (right-click >> Delete, all the other files will disappear). Then right-click and select Add >> File. Look in the bin directory in the CORSIM Output Processor v1.1 project directory and select CORSIM Output Processor v1.1.exe. Several other files will automatically be added since they are dependencies of the exe file. Add the NIATT CORSIM DLL.dll file to the bin directory as well. Next recreate the shortcut to CORSIM Output Processor v1.1.exe in the User’s Desktop folder, and also in the User’s Program Menu/NIATT COP folder. Do this by deleting the old shortcuts, then right-clicking and selecting Create new shortcut. Make sure to build the binary files for the CORSIM Output Processor project first, then build the Install CORSIM Output Processor project.
4. INSTRUCTIONS FOR CASE STUDIES: TRAFFIC CONTROLLER LABORATORY II

4.1 INSTRUCTIONS

Instructions for six different case studies provide users step-by-step guides to remotely access to NIATT Traffic Controller Laboratory II and conduct simulation with or without Hardware-In-Loop Simulation (HILS) using CORSIM/VISSIM.

CORSIM:
- Case 1: Run simulation (without HILS) for one intersection with CORSIM
- Case 2: Run HILS for one intersection with CORSIM and Aries
- Case 3: Run HILS for three intersections (Time-Based Coordinated System) with CORSIM and Aries
- Case 4: Run HILS for three intersections (Master-Based Coordinated System) with CORSIM and Aries

VISSIM:
- Case 5: Run simulation (without HILS) for one intersection with VISSIM
- Case 6: Run HILS for one intersection with VISSIM and Aries
4.2 CASE STUDIES

CASE 1: Run simulation (without HILS) for one intersection with CORSIM

Transfer a File for CORSIM Simulation

1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 1-1).

![Figure 1-1 Network Drives on Remote Computer](image)

2. Click on the TSIS icon to start the program TSIS 5.0 from the RAHILS host computer 2.
3. Start a new project file (e.g. Remote Simulation) from the RAHILS host computer 2 (Fig. 1-11) and (Fig. 1-2).
4. Navigate to the file or files (*.trf) you want to transfer using the network drives, then copy to C: TSIS Projects\Remote Simulation on RAHILS host computer 2. For example, if you want to transfer a (*.trf) file (Moscow_2003AM.trf) located at C:simulations from your local computer, then open the C on YOUR LOCAL COMPUTER drive and navigate to the simulations folder (where YOUR LOCAL COMPUTER is the name of your own computer) and copy to C: TSIS Projects\Remote Simulation on the RAHILS host computer 2.

5. Select Simulation (*.trf) file under directory TSIS Projects\Remote Simulation, then click on CORSIM Simulation button to run the simulation (Fig. 1-3).
6. Click on TRAFVU Button to view the animation (Fig. 1-4).

7. View Text output by clicking Output (*.out). Output file shows input information of link, signal control input data, performance of simulated system, such as delay time, queue time, stop time and cumulative values for the entire network.

8. If you need to transfer files from the RAHILS host computer 2 to your local computer, simply reverse the process. Drag and drop or copy and paste files from drives of the RAHILS host computer 2 to a location on your network drive.
CASE 2: Run HILS for One Intersection with CORSIM and Aries

Program Controller Settings
Before conducting simulations, users must program signal timing plan parameters on the remote traffic controllers. Using the Controller Interface Network Device (CIN), users will run traffic management software for each of the controllers in the bank they are using.

The Controller Interface Network (CIN) device is a COM (RS232) port switch box that allows Host computer 1 to connect to the traffic controllers in the lab.

1. Run the Remote Desktop Connection to connect to host computer 1, which runs traffic management software

2. From the Start menu of the host computer 1, select Programs, scroll to Controller Interconnection Network and to Controller Interconnection Network and release the mouse (Fig. 2-1).

3. In the COM Port Configuration for Controller Interconnection Network dialog box, select COM1 and click Proceed (Fig. 2-2).

4. In the Controller Interconnection Network GUI, a Setup button appears above the image of each controller (Fig. 2-3). Press Setup for one controller. The line between the host computer and traffic controller will change from dashes to a solid green line, indicating that the controller is connected to the host computer.
Add New Zones (Subsystems) Using Aries

1. In the Aries Zone Manager window, right click Zones and select Add Zone. This takes you into the Add Zone Node window.
2. The window defaults to the next unused zone number, which you may overwrite as necessary.
3. Enter the Telephone Number if the zone is connected via a modem. Add any applicable dialing prefixes or long distance codes. Insert spaces, hyphens and parentheses. Insert a comma for a dialing pause or leave blank in case of direct connect.
4. Enter Bank 1 in the Zone Name. This also can be the name of the street for an arterial with multiple intersections.
5. Click in the field for Zone Type and make a selection from the pulldown menu.
6. Click on the field for Bit Rate and make a selection from the pulldown menu. The normal choice should be 2400 bps. Use 1200 bps or 300 bps for older, slower modems in the field. This does not apply to Intersection Monitor II, ASC-8000 or ASC/2 direct zones.
7. Enter the Access Code for any Zone Master where an access code is required for security purposes. This code has been entered manually into the master or controller to prevent unauthorized program modification.
8. Check the box Create New Master Data File. This creates a data file for that zone on the Aries computer.
9. Click on OK. The Data Rate Selection window appears. Enter the same bit rate as entered previously, typically 2400 or 1200 bps.
10. Click on OK to complete data entry for the zone Bank 1 (Fig. 2-4).
Edit a Previously Entered Zone
1. Select the Aries Zone Manager window.
2. Right-click on Zone 1 and select Edit Zone Properties from the pulldown menu.
3. The Edit Zone Node window appears. Make the necessary changes and click on OK to accept them or Cancel to end the operation (Fig. 2-5).
Add Intersections to a Zone Using Aries

1. In the Aries Zone Manager window, right-click on the Zone 1.
2. Select Add Intersection and supply the Data Change access code. The Add Intersection Node window appears, suggesting the next available number for the intersection.
3. In the Intersection Name field, enter the name of the intersection TC1. If street names are used, normally two street names separated by an ampersand (&).
4. In the Controller Type data field, select a controller from the pulldown menu. Choices are ASC2 for the ASC/2 series, ASC for the ASC-8000 series (Fig. 2-6). Press OK.
5. Depending on the type of controller selected, a controller sub type window appears prompting you to select a controller sub-type. In case of the ASC/2, this refers to NEMA TS2 type (Type 1 or Type 2) and the size of the EEPROM data module (8K or 32K). TS2 Type 2 includes TS1 emulation. In case of the ASC-8000, refers to an EEPROM version (C8000, C8001 or C8021)

Upload Master Data

1. In the Aries Zone Manager window, right-click on the zone 1.
2. Select Upload Master Data and press Start to begin the operation (Fig. 2-7).
3. The message ‘Upload Complete. SAVE, COMPARE OR CANCEL appears.
4. Select Save if this was your first upload to save the two-kilobyte file on disk. The Compare option allows you to compare the uploaded data with data from a previously saved master data file for that zone. Cancel ends the operation.
Edit Master Data

1. In the Aries Zone Manager window, right-click on the Zone 1.
2. Select Launch from the Menu bar and select Data Entry.
3. Enter the Data Entry access code, defined earlier, to prevent unauthorized data modification. The Aries Data Entry for Zone window appears.
4. Make data change if necessary.
5. Save the data and close the window.
Compare Master Data
To compare the master data in the computer and in the equipment in the field:
1. From the Aries Zone Manager window, right-click on the zone.
2. Select Compare Master Data, then Parameter Compare.
3. In the Operation Progress Messages window, click the Start button. The Aries system compares the disk file to the uploaded file.
4. The Aries Data Entry for Zone window appears and shows any discrepancy in two one-line fields at the bottom. Use the Back and Next buttons of the window to cycle between multiple discrepancy messages.

Download Master Data
1. In the Aries Zone Manager window, right-click on the zone.
2. Select Download Master Data and press Start to begin the operation. The master download operation is completed when the message **** Operation Complete **** appears.
3. Close the window. A compare operation at this time shows the disk files and the field files match.

Upload Local Controller Data
1. In the Aries Zone Manager window, right-click on the intersection.
2. Click on Upload Local Controller Data.
3. When prompted to select the segments to upload, select only the segments that you need, a full upload from a controller through a zone master can take up to 15 minutes (Fig. 2-9).
4. Press Start. When you upload controller data from an intersection for the first time, the message, Configuration does not match appears. This is normal. Choose Proceed.
5. When the upload is complete, select Save to store the uploaded data in the appropriate directory on disk.
1. In the Aries Zone Manager window, right-click on the intersection and click on Controller Data Entry. Enter the Data Entry Access Code (Fig 2-10).

2. The Aries Data Entry screen appears. On the left hand side of the screen, there is a topic selection index. Clicking on each topic presents you with a different data entry sub-screens, located to the right of the index. The index tabs reflect other information topics to choose from, depending on the topic selected.

3. Make a minor change. For instance, select By Phase Timing Data and Min Timing. Change a Minimum Green Interval by 5 seconds. Click on Save under the File pull-down menu.

Compare ASC/2 Controller Data
To compare ASC/2 file and controller data:

1. In the Aries Zone Manager window, right-click on the intersection and click on Compare Local Controller Data (Fig. 2-11).

There are three options to choose from:
- Byte Compare provides pass/fail indication by segment (or topic) by comparing the data one byte at a time.
- Quick Compare also provides pass/fail indication by segment, but in much less time by limiting the comparison to 16-bit CRC results.
- Parameter Compare identifies the specific elements that differ.
Figure 2-10 Edit ASC/2 Local Controller Data

Figure 2-11 Compare ASC/2 Controller Data
2. Select Parameter Compare. Select the segments to be compared. Selecting fewer segments saves time. Press Start to begin the upload of data from the ASC/2 controller.

3. At the Aries Data Entry screen, the two fields at the bottom of the screen list any differences between the uploaded controller data and file data. Click on Next to move to the next difference. Click on Back to return to the previous difference.

4. Make any database changes using the Aries Data Entry screen. Select Save under the File pull-down menu to save any changes to disk. Begin a download operation to enter the file data into the ASC/2 controller.

**Download Controller Data**

1. In the Aries Zone Manager window, right-click on the intersection and click on Download Local Controller Data. A dialog box appears, allowing you to choose the segments to be downloaded (Fig. 2-12).

2. Choose either all the segments or certain ones to download. Selecting only the segments you need to download, thus speeds up the download process and saves time.

![ASC/2 Segments](image)

*Figure 2-12 Segments for Local Controller Data Downloading*

**Check the Status of the CIDs**

NIATT’s controller interface devices (CIDs) should be ready for remote access through Host computer 2. However, the user needs to verify the status of the CIDs using the Hardware Tester software.

1. Click Start. Select Programs. Scroll to McCain-NIATT CID II and then CID Hardware Tester (Fig. 2-13).

2. The right side of the CID Hardware Tester (Fig. 2-14) displays the CID identification numbers.
3. The CIDs are working properly if the ID number is displayed.
4. When the Hardware Tester indicates that everything is working properly, exit the CID Hardware Tester.

Transfer a File for Hardware-in-the-Loop Simulation
1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 2–15).
2. Navigate to the file or files (*.trf) you want to transfer using the network drives then copy to `C: TSIS Projects\ExistingSignal` (for example) on RAHILS host computer 2. For instance, if you want to transfer a (*.trf) file (Casestudy2.trf) located at C:\simulations\Casestudy2.trf from your local computer, then open the C on YOURLOCALCOMPUTER drive and navigate to the simulations folder (where YOURLOCALCOMPUTER is the name of your local computer) and copy the file of Casestudy2.trf to `C: TSIS Projects\ExistingSignal` on the RAHILS host computer 2.

**Configure Controller Interface Device (CID)**

The controller interface device is a tool that allows traffic controllers to communicate with simulations running on host computer 2. For HILS to function properly, the CID should be configured by the following steps:

1. Open the CID Configuration Tool (Usually under Start - Programs - McCain/NIATT CID II) from host computer 2.
2. Open the *.trf file of Casestudy2.trf which is transferred from your local computer and saved in host computer 2.
3. Follow the following steps for the node that will be assigned a CID (Fig. 2-16):
   a. Select a node to be assigned to a CID
   b. In the CID Intersection Data screen specify:
i. Phase assignments to each vehicle turning movement and pedestrian movement
ii. Define the type of left turn phasing (Protected, Perm, or PP)
iii. Specify the controller type (NEMA TS1)

4. Save the *.CID and *.TRF files in Cases Study 2, saying yes to all prompts.

---

**Figure 2-16 CID Configuration**

**Conduct CORSIM and HILS simulation**

1. Click on the TSIS icon to start the program TSIS 5.0 from the RAHILS host computer 2.
2. Open the file (*.trf) of Casestudy2.trf with TSIS, which is already configured by CIDs and saved in the RAHILS host computer 2.
3. Click once the *.trf file of Casestudy2, run real time simulation by pressing the SIM button in TSIS (not the CORSIM simulation button.) (Fig. 2-17).
4. Click on TRAFVU Button to view the real time animation (Fig. 2-18).
5. View Text output by clicking Output (*.out). Output file shows input information of link, signal control input data, performance of simulated system, such as delay time; queue time; and stop time and also provides cumulative values for the entire network.

6. If you need to transfer files from the RAHILS computer to your local computer, simply reverse the process. Drag and drop or copy and paste files from the RAHILS local drives to a location on your network drive.
CASE 3: Run HILS for Three Intersections (Time-Based Coordinated System) with CORSIM and Aries

Program Controller Settings
Before conducting simulations, users must program signal timing plan parameters on the remote traffic controllers. Using the Controller Interface Network Device (CIN), users will run traffic management software for each of the controllers in the bank they are using.

The Controller Interface Network (CIN) device is a COM (RS232) port switch box that allows Host computer 1 to connect to the traffic controllers in the lab.

1. Run the Remote Desktop Connection to connect to host computer 1, which runs traffic management software

2. From the Start menu of the host computer 1, select Programs, scroll to Controller Interconnection Network and to Controller Interconnection Network and release the mouse (Fig. 3-1).

![Figure 3-1 Controller Interconnection Network Menu](image)

3. In the COM Port Configuration for Controller Interconnection Network dialog box, select COM1 and click Proceed (Fig. 3-2).

![Figure 3-2 COM Port Selection](image)

4. In the Controller Interconnection Network GUI, a Setup button appears above the image of each controller. Press Setup for Controller 1. The line between the host
computer and traffic controller will change from dashes to a solid green line, indicating that the controller is connected to the host computer (Fig. 3-3)

Figure 3-3 Controller Interconnection Network GUI

Add New Zones Using Aries
1. In the Aries Zone Manager window, right click Zones and select Add Zone. This takes you into the Add Zone Node window.
2. The window defaults to the next unused zone number, which you may overwrite as necessary.
3. Enter the Telephone Number if the zone is connected via a modem. Add any applicable dialing prefixes or long distance codes. Insert spaces, hyphens and parentheses. Insert a comma for a dialing pause or leave blank in case of direct connect.
4. Enter Bank 1 in the Zone Name. This also can be the name of the street for an arterial with multiple intersections.
5. Click in the field for Zone Type and make a selection from the pulldown menu.
6. Click on the field for Bit Rate and make a selection from the pulldown menu. The normal choice should be 2400 bps. Use 1200 bps or 300 bps for older, slower modems in the field. This does not apply to Intersection Monitor II, ASC-8000 or ASC/2 direct zones.
7. Enter the Access Code for any Zone Master where an access code is required for security purposes. This code has been entered manually into the master or controller to prevent unauthorized program modification.

8. Check the box Create New Master Data File. This creates a data file for that zone on the Aries computer.

9. Click on OK. The Data Rate Selection window appears. Enter the same bit rate as entered previously, typically 2400 or 1200 bps.

10. Click on OK to complete data entry for the zone Bank 1 (Fig. 3-4).

![Aries Zone Manager screenshot](image)

**Figure 3-4 Create Zones**

**Edit a Previously Entered Zone**

1. Select the Aries Zone Manager window.
2. Right-click on Zone 1 and select Edit Zone Properties from the pulldown menu.
3. The Edit Zone Node window appears. Make the necessary changes and click on OK to accept them or Cancel to end the operation (Fig. 3-5).
Add Intersections to a Zone Using Aries

To add an intersection to a zone

1. In the Aries Zone Manager window, right-click on the Zone 1.
2. Select Add Intersection and supply the Data Change access code. The Add Intersection Node window appears, suggesting the next available number for the intersection.
3. In the Intersection Name field, enter the name of the intersection TC1. If street names are used, normally two street names separated by an ampersand (&).
4. In the Controller Type data field, select a controller from the pulldown menu. Choices are ASC2 for the ASC/2 series, ASC for the ASC-8000 series. Press OK (Fig. 3-6).
5. Depending on the type of controller selected, a controller sub type window appears prompting you to select a controller sub-type. In case of the ASC/2, this refers to NEMA TS2 type (Type 1 or Type 2) and the size of the EEPROM data module (8K or 32K). TS2 Type 2 includes TS1 emulation. In case of the ASC-8000, refers to an EEPROM version (C8000, C8001 or C8021).
6. Repeat steps 1-5 above to add other intersections to Zone 1 (Fig. 3-7).

**Upload Master Data**

1. In the Aries Zone Manager window, right-click on the desired zone.
2. Select Upload Master Data and press Start to begin the operation (Fig. 3-8).
3. The message Upload Complete. SAVE, COMPARE OR CANCEL appears.
4. Select Save if this was your first upload to save the two-kilobyte file on disk. The Compare option allows you to compare the uploaded data with data from a previously saved master data file for that zone. Cancel ends the operation.
To edit the master data that you have uploaded:

1. In the Aries Zone Manager window, right-click on the zone.
2. Select Launch from the Menu bar and select Data Entry.
3. Enter the Data Entry access code, defined earlier, to prevent unauthorized data modification. The Aries Data Entry for Zone window appears (Fig. 3-9).
4. Make data change if necessary.
5. Save the data and close the window.

---

**Figure 3-8 Upload Master Data**

**Figure 3-9 Edit Master Data**
Compare Master Data
To compare the master data in the computer and in the equipment in the field:
1. From the Aries Zone Manager window, right-click on the zone.
2. Select Compare Master Data, then Parameter Compare.
3. In the Operation Progress Messages window, click the Start button. The Aries system compares the disk file to the uploaded file.
4. The Aries Data Entry for Zone window appears and shows any discrepancy in two one-line fields at the bottom. Use the Back and Next buttons of the window to cycle between multiple discrepancy messages.

Download Master Data
1. In the Aries Zone Manager window, right-click on the zone.
2. Select Download Master Data and press Start to begin the operation. The master download operation is completed when the message ‘**** Operation Complete ****’ appears.
3. Close the window. A compare operation at this time shows the disk files and the field files match.

Upload Local Controller Data
1. In the Aries Zone Manager window, right-click on the intersection.
2. Click on **Upload Local Controller Data** (Fig. 3-10).
3. When prompted to select the segments to upload, select only the segments that you need, a full upload from a controller through a zone master can take up to 15 minutes.
4. Press **Start**. When you upload controller data from an intersection for the first time, the message, **Configuration does not match** appears. This is normal. Choose Proceed.

5. When the upload is complete, select **Save** to store the uploaded data in the appropriate directory on disk.

**Edit ASC/2 Local Controller Data**

1. In the Aries Zone Manager window, right-click on the intersection and click on Controller Data Entry. Enter the Data Entry Access Code.

2. The Aries Data Entry screen appears. On the left hand side of the screen, there is a topic selection index (Fig. 3-11). Clicking on each topic presents you with a different data entry sub-screens, located to the right of the index. The index tabs reflect other information topics to choose from, depending on the topic selected.

3. Make a minor change. For instance, select By Phase Timing Data and Min Timing. Change a Minimum Green Interval by 5 second. Click on **Save** under the File pull-down menu.

![Figure 3-11 Edit ASC/2 Local Controller Data](image)

**Compare ASC/2 Controller Data**

To compare ASC/2 file and controller data:

1. In the Aries Zone Manager window, right-click on the intersection and click on Compare Local Controller Data. There are three options to choose from:

   - Byte Compare provides pass/fail indication by segment (or topic) by comparing the data one byte at a time.
• Quick Compare also provides pass/fail indication by segment, but in much less time by limiting the comparison to 16-bit CRC results.
• Parameter Compare identifies the specific elements that differ.

2. Select Parameter Compare. Select the segments to be compared. Selecting fewer segments saves time. Press Start to begin the upload of data from the ASC/2 controller.

3. At the Aries Data Entry screen, the two fields at the bottom of the screen list any differences between the uploaded controller data and file data (Fig. 3-12). Click on Next to move to the next difference. Click on Back to return to the previous difference.

4. Make any database changes using the Aries Data Entry screen. Select Save under the File pull-down menu to save any changes to disk. Begin a download operation to enter the file data into the ASC/2 controller.

Figure 3-12 Compare ASC/2 Controller Data

**Download Controller Data**

1. In the Aries Zone Manager window, right-click on the intersection and click on Download Local Controller Data. A dialog box appears, allowing you to choose the segments to be downloaded (Fig. 3-13).

2. Choose either all the segments or certain ones to download. Selecting only the segments you need to download, thus speeds up the download process and saves time.
Check the Status of the CIDs
NIATT’s controller interface devices (CIDs) should be ready for remote access through Host computer 2. However, the user needs to verify the status of the CIDs using the Hardware Tester software.

1. Click Start. Select Programs. Scroll to McCain-NIATT CID II, and then CID Hardware Tester (Fig. 3-14).

2. The right side of the CID Hardware Tester (Fig. 3-15) displays the CID identification numbers. Press the Space bar to toggle between the CIDs.
3. The CIDs are working properly if different ID numbers are displayed.
4. When the Hardware Tester indicates that everything is working properly, exit the CID Hardware Tester.
Transfer a File for Hardware-in-the-Loop Simulation

1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 3-16).

![Figure 3-15 CID Hardware Tester Screen](image1)

![Figure 3-16 Network Drives on Remote Computer](image2)
2. Navigate to the file or files (.trf) you want to transfer using the network drives then copy to `C: TSIS Projects\ExistingSignal` (for example) on RAHILS host computer 2. For instance, if you want to transfer a (*.trf) file (Casestudy2.trf) located at `C:\simulations\Casestudy2.trf` from your local computer, then open the C on YOUR LOCAL COMPUTER drive and navigate to the simulations folder (where YOUR LOCAL COMPUTER is the name of your local computer) and copy the file of Casestudy2.trf to `C: TSIS Projects\ExistingSignal` on the RAHILS host computer 2.

**Configure Controller Interface Device (CID)**

The Controller Interface Device is a tool that allows traffic controllers to communicate with simulations running on host computer 2. For HILS to function properly, the CID should be configured following basic steps (Fig. 3-17):

1. Open the CID Configuration Tool (Usually under Start - Programs - McCain/NIATT CID II) from host computer 2.
2. Open the *.trf file of Casestudy2.trf which is transferred from your local computer and saved in host computer 2.
3. Follow the following steps to assign CIDs for 3 nodes; each node will be assigned a CID:
   a. Select a node to be assigned to a CID
   b. In the CID Intersection Data screen specify:
      i. Phase assignments to each vehicle turning movement and pedestrian movement
      ii. Define the type of left turn phasing (Protected, Perm, or PP)
      iii. Specify the controller type (NEMA TS1)
4. Save the *.CID and *.TRF files in Casestudy2, saying yes to all prompts.

![Figure 3-17 CID Configuration](image-url)
Conduct CORSIM and HILS Simulation

1. Click on the TSIS icon to start the program from the RAHILS host computer 2.
2. Open the file (*.trf) of Casestudy2.trf with TSIS, which is already configured by CIDs and saved in the RAHILS host computer 2.
3. Click once *.trf file of Casestudy2, run real time simulation by pressing the SIM button in TSIS (not the CORSIM simulation button.). Make sure that the controller(s) have been properly programmed (Fig. 3-18).
4. Click on TRAFVU Button to view the real time animation (Fig. 3-19).
5. View Text output by clicking Output (*.out). Output file shows input information of link, signal control input data, performance of simulated system, such as delay time; queue time; and stop time and also provides cumulative values for the entire network.
6. If you need to transfer files from the RAHILS computer to your local computer, simply reverse the process. Drag and drop or copy and paste files from the RAHILS local drives to a location on your network drive.

Figure 3-18 CORSIM and HILS Simulation
Figure 3-19 CORSIM HILS Real Time Animation
CASE 4: Run HILS for Three Intersections (Master-Based Coordinated System) with CORSIM and Aries

Program Controller Settings
Before conducting simulations, users must program signal timing plan parameters on the remote traffic controllers. Using the Controller Interface Network Device (CIN), users will run traffic management software for each of the controllers in the bank they are using.

The Controller Interface Network (CIN) device is a COM (RS232) port switch box that allows Host computer 1 to connect to the traffic controllers in the lab.

1. Run the Remote Desktop Connection to connect to host computer 1, which runs traffic management software.
2. From the Start menu of the host computer 1, select Programs, scroll to Controller Interconnection Network and to Controller Interconnection Network and release the mouse (Fig. 4-10).

3. In the COM Port Configuration for Controller Interconnection Network dialog box, select COM1 and click Proceed (Fig. 4-2).
4. In the Controller Interconnection Network GUI, a Setup button appears above the image of each controller (Fig. 4-3). Press Setup for Controller 1. The line between the host computer and traffic controller will change from dashes to a solid green line, indicating that the controller is connected to the host computer.
5. Once the controller has been programmed, the Setup button will read Done. Click Done.
6. Repeat steps Step 4, 5, 6 and 7 to program controller 2 and controller 3.
7. Master controller should be set up for Master-Based Coordination. In the Controller Interconnection Network GUI, a Setup button appears below the image of Master Traffic Controller. Press Setup for Master Traffic Controller, the line between the host computer and Master Traffic Controller will change from dashes to a solid green line, indicating that the Master Traffic Controller is connected to the host computer.

Add New Zones Using Aries
1. In the Aries Zone Manager window, right click Zones and select Add Zone. This takes you into the Add Zone Node window.
2. The window defaults to the next unused zone number, which you may overwrite as necessary.
3. Enter the Telephone Number if the zone is connected via a modem. Add any applicable dialing prefixes or long distance codes. Insert spaces, hyphens and parentheses. Insert a comma for a dialing pause or leave blank in case of direct connect.
4. Enter Bank 1 in the Zone Name. This also can be the name of the street for an arterial with multiple intersections.
5. Click in the field for Zone Type and make a selection from the pulldown menu.
6. Click on the field for Bit Rate and make a selection from the pulldown menu. The normal choice should be 2400 bps. Use 1200 bps or 300 bps for older, slower modems in the field. This does not apply to Intersection Monitor II, ASC-8000 or ASC/2 direct zones.
7. Enter the Access Code for any Zone Master where an access code is required for security purposes. This code has been entered manually into the master or controller to prevent unauthorized program modification.

8. Check the box Create New Master Data File. This creates a data file for that zone on the Aries computer.

9. Click on OK. The Data Rate Selection window appears. Enter the same bit rate as entered previously, typically 2400 or 1200 bps.

10. Click on OK to complete data entry for the zone Bank 1 (Fig. 4-4).

Figure 4-4 Create Zones

Edit a Previously Entered Zone
1. Select the Aries Zone Manager window.
2. Right-click on Zone 1 and select Edit Zone Properties from the pulldown menu.
3. The Edit Zone Node window appears. Make the necessary changes and click on OK to accept them or Cancel to end the operation (Fig. 4-5).
Add Intersections to a Zone using Aries

1. In the Aries Zone Manager window, right-click on the Zone 1.
2. Select Add Intersection and supply the Data Change access code. The Add Intersection Node window appears, suggesting the next available number for the intersection.
3. In the Intersection Name field, enter the name of the intersection TC1. If street names are used, normally two street names separated by an ampersand (&).
4. In the Controller Type data field, select a controller from the pulldown menu. Choices are ASC2 for the ASC/2 series, ASC for the ASC-8000 series. Press OK (Fig. 4-6).
5. Depending on the type of controller selected, a controller sub type window appears prompting you to select a controller sub-type. In case of the ASC/2, this refers to NEMA TS2 type (Type 1 or Type 2) and the size of the EEPROM data module (8K or 32K). TS2 Type 2 includes TS1 emulation. In case of the ASC-8000, refers to an EEPROM version (C8000, C8001 or C8021).
6. Repeat steps 1-5 above to add other intersections to Zone 1 (Fig. 4-7).
Upload Master Data
1. In the Aries Zone Manager window, right-click on the desired zone.
2. Select Upload Master Data and press Start to begin the operation (Fig. 4-8).
3. The message ‘Upload Complete. SAVE, COMPARE OR CANCEL appears.
4. Select Save if this was your first upload to save the two-kilobyte file on disk. The Compare option allows you to compare the uploaded data with data from a previously saved master data file for that zone. Cancel ends the operation.

![Image of Aries Zone Manager window](image)

**Figure 4-8 Upload Master Data**

**Edit Master Data**

To edit the master data that you have uploaded:

1. In the Aries Zone Manager window, right-click on the zone.
2. Select Launch from the Menu bar and select Data Entry (Fig. 4-9).
3. Enter the Data Entry access code, defined earlier, to prevent unauthorized data modification. The Aries Data Entry for Zone window appears.
4. Make data change if necessary.
5. Save the data and close the window.
Compare Master Data
To compare the master data in the computer and in the equipment in the field:
1. From the Aries Zone Manager window, right-click on the zone.
2. Select Compare Master Data, then Parameter Compare.
3. In the Operation Progress Messages window, click the Start button. The Aries system compares the disk file to the uploaded file.
4. The Aries Data Entry for Zone window appears and shows any discrepancy in two one-line fields at the bottom. Use the Back and Next buttons of the window to cycle between multiple discrepancy messages.

Download Master Data
1. In the Aries Zone Manager window, right-click on the zone.
2. Select Download Master Data and press Start to begin the operation. The master download operation is completed when the message ‘**** Operation Complete ****’ appears.
3. Close the window. A compare operation at this time shows the disk files and the field files match.

Upload Local Controller Data
1. In the Aries Zone Manager window, right-click on the intersection.
2. Click on Upload Local Controller Data.
3. When prompted to select the segments to upload, select only the segments that you need, a full upload from a controller through a zone master can take up to 15 minutes (Fig. 4-10).
4. Press **Start**. When you upload controller data from an intersection for the first time, the message, **Configuration does not match** appears. This is normal. Choose Proceed.
5. When the upload is complete, select **Save** to store the uploaded data in the appropriate directory on disk.

![Figure 4-10 Upload Local Controller Data](image)

**Figure 4-10 Upload Local Controller Data**

**Edit ASC/2 Local Controller Data**

1. In the Aries Zone Manager window, right-click on the intersection and click on Controller Data Entry. Enter the Data Entry Access Code.
2. The Aries Data Entry screen appears. On the left hand side of the screen, there is a topic selection index. Clicking on each topic presents you with a different data entry sub-screens, located to the right of the index (Fig. 4-11). The index tabs reflect other information topics to choose from, depending on the topic selected.
3. Make a minor change. For instance, select By Phase Timing Data and Min Timing. Change a Minimum Green Interval by 5 second. Click on Save under the File pull-down menu.
Compare ASC/2 Controller Data
To compare ASC/2 file and controller data:

1. In the Aries Zone Manager window, right-click on the intersection and click on Compare Local Controller Data. There are three options to choose from:
   - Byte Compare provides pass/fail indication by segment (or topic) by comparing the data one byte at a time.
   - Quick Compare also provides pass/fail indication by segment, but in much less time by limiting the comparison to 16-bit CRC results.
   - Parameter Compare identifies the specific elements that differ.

2. Select Parameter Compare. Select the segments to be compared. Selecting fewer segments saves time. Press Start to begin the upload of data from the ASC/2 controller.

3. At the Aries Data Entry screen, the two fields at the bottom of the screen list any differences between the uploaded controller data and file data. Click on Next to move to the next difference. Click on Back to return to the previous difference.

4. Make any database changes using the Aries Data Entry screen. Select Save under the File pull-down menu to save any changes to disk. Begin a download operation to enter the file data into the ASC/2 controller.
Download Controller Data
1. In the Aries Zone Manager window, right-click on the intersection and click on Download Local Controller Data. A dialog box appears, allowing you to choose the segments to be downloaded.
2. Choose either all the segments or certain ones to download. Selecting only the segments you need to download, thus speeds up the download process and saves time (Fig. 4-13).

Check the Status of the CIDs
NIATT’s controller interface devices (CIDs) should be ready for remote access through Host computer 2. However, the user needs to verify the status of the CIDs using the Hardware Tester software.
1. Click Start. Select Programs. Scroll to McCain-NIATT CID II and then to CID Hardware Tester (Fig. 4-14).

![Figure 4-14 CID Software Suite Menu](image)

2. The right side of the CID Hardware Tester (Fig.4-15) displays CID identification numbers. Press the Space bar to toggle between the CIDs.

![Figure 4-15 CID Hardware Tester Screen](image)

3. The CIDs are working properly if different ID numbers are displayed.
4. When the Hardware Tester indicates that everything is working properly, exit the CID Hardware Tester.

**Transfer a File for Hardware-in-the-Loop Simulation**

1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 4 16).
2. Navigate to the file or files (.trf) you want to transfer using the network drives then copy to C: TSIS Projects\ExistingSignal (for example) on RAHILS host computer 2. For instance, if you want to transfer a (*.trf) file (Casestudy2.trf) located at C:\simulations\Casestudy2.trf from your local computer, then open the C on YOUR LOCAL COMPUTER drive and navigate to the simulations folder (where YOURLOCALCOMPUTER is the name of your own computer) and copy the file of Casestudy2.trf to C: TSIS Projects\Existingsignal on the RAHILS host computer 2.

Configure Controller Interface Device (CID)

The controller interface device is a tool that allows traffic controllers to communicate with simulations running on host computer 2. For HILS to function properly, the CID should be configured:

1. Open the CID Configuration Tool (Usually under Start - Programs - McCain/NIATT CID II) from host computer 2
2. Open the *.trf file of Casestudy2.trf which is transferred from your local computer and saved in host computer 2
3. Follow the following steps to assign CIDs for 3 nodes, each node will be assigned a CID:
   a. Select a node to be assigned to a CID
   b. In the CID Intersection Data screen specify:
      i. Phase assignments to each vehicle turning movement and pedestrian movement
      ii. Define the type of left turn phasing (Protected, Perm, or PP)
      iii. Specify the controller type (NEMA TS1)
4. Save the *.CID and *.TRF files in Casestudy2, saying yes to all prompts.
Conduct CORSIM and HILP Simulation

1. Click on the TSIS icon to start the program TSIS 5.0 from the RAHILS host computer 2.
2. Open the file (*.trf) of Casestudy2.trf with TSIS, which is already configured by CIDs and saved in the RAHILS host computer 2.
3. Run the *.trf file of Casestudy2 by pressing the CID Real-Time Simulation button in TSIS (not the CORSIM simulation button.) Make sure that the controller(s) have been properly programmed (Fig. 4-18).
4. Click on TRAFVU Button to view the real time animation (Fig. 4-19).

![TRAFVU - CaseStudy2.trf](image)

**Figure 4-19 CORSIM HILS Real Time Animation**

5. View Text output by clicking Output (*.out). Output file shows input information of link, signal control input data, performance of simulated system, such as delay time; queue time; and stop time and also provides cumulative values for the entire network.

6. If you need to transfer files from the RAHILS computer to your local computer, simply reverse the process. Drag and drop or copy and paste files from the RAHILS local drives to a location on your network drive.
CASE 5: Run Simulation (without HILS) for One Intersection with VISSIM

Transfer a file for VISSIM simulation

1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 5-1).

2. Click Start-Programs-PTV_Vision-VISSIM 4.0 to start VISSIM program from RAHILS host computer 2.

3. Create a new directory from the RAHILS host computer 2.

4. Navigate to the file or files (inp) of interest you want to transfer using the network drives then copy to the new directory C:\Program Files\PTV_Vision\VISSIM400\Remote Simulation on RAHILS host computer 2. For example, if you want to transfer a (*.inp) file (Moscow.inp) located at C:\simulations from your local computer, then open the C on YOUR LOCAL COMPUTER drive and navigate to the simulations folder (where YOURLOCALCOMPUTER is the name of your local computer) and copy to C:\Program Files\PTV_Vision\VISSIM400\Remote Simulation on the RAHILS host computer 2.

5. Launch VISSIM in RAHILS host computer 2 if it is not already open.

6. With the .inp file of interest open, Click Simulation button to run the simulation with VISSIM on RAHILS host computer 2 (Fig. 5-2).
7. After the simulation is completed, you can use the *VISSIM* output results as you normally would.

8. If you need to transfer files from the RAHILS host computer 2 to your local computer, simply reverse the process. Drag and drop or copy and paste files from local drives of the RAHILS host computer 2 to a location on your network drive.

---

**Figure 5-2 VISSIM Simulation**

- *Vehicles*
- *Detectors*
CASE 6: Run HILS for One Intersection with VISSIM and Aries

Program Controller Settings
Before conducting simulations, users must program signal timing plan parameters on the remote traffic controllers. Using the Controller Interface Network Device (CIN), users will run traffic management software for each of the controllers in the bank they are using.

The Controller Interface Network (CIN) device is a COM (RS232) port switch box that allows Host computer 1 to connect to the traffic controllers in the lab.

1. Run the Remote Desktop Connection to connect to host computer 1, which runs traffic management software
2. From the Start menu of the host computer 1, select Programs, scroll to Controller Interconnection Network and to Controller Interconnection Network and release the mouse (Fig. 6-1).

   Figure 6-1 Controller Interconnection Network menu

3. In the COM Port Configuration for Controller Interconnection Network dialog box, select COM1 and click Proceed (Fig. 6-2).

   Figure 6-2 COM Port Selection

4. In the Controller Interconnection Network GUI, a Setup button appears above the image of each controller (Fig. 6-3). Press Setup for one controller. The line between the host computer and traffic controller will change from dashes to a solid green line, indicating that the controller is connected to the host computer.
5. Once the controller has been programmed, the Setup button will read Done. Click Done.

![Controller Interconnection Network GUI](image)

Figure 6-3 Controller Interconnection Network GUI

**Add New Zones Using Aries**

1. In the Aries Zone Manager window, right click Zones and select Add Zone. This takes you into the Add Zone Node window.
2. The window defaults to the next unused zone number, which you may overwrite as necessary.
3. Enter the Telephone Number if the zone is connected via a modem. Add any applicable dialing prefixes or long distance codes. Insert spaces, hyphens and parentheses. Insert a comma for a dialing pause or leave blank in case of direct connect.
4. Enter Bank 1 in the Zone Name. This also can be the name of the street for an arterial with multiple intersections.
5. Click in the field for Zone Type and make a selection from the pulldown menu.
6. Click on the field for Bit Rate and make a selection from the pulldown menu. The normal choice should be 2400 bps. Use 1200 bps or 300 bps for older, slower modems in the field. This does not apply to Intersection Monitor II, ASC-8000 or ASC/2 direct zones.
7. Enter the Access Code for any Zone Master where an access code is required for security purposes. This code has been entered manually into the master or controller to prevent unauthorized program modification.
8. Check the box Create New Master Data File. This creates a data file for that zone on the Aries computer.
9. Click on OK. The Data Rate Selection window appears. Enter the same bit rate as entered previously, typically 2400 or 1200 bps.
10. Click on OK to complete data entry for the zone Bank 1 (Fig. 6-4).
Edit a Previously Entered Zone

1. Select the Aries Zone Manager window.
2. Right-click on Zone 1 and select Edit Zone Properties from the pulldown menu.
3. The Edit Zone Node window appears. Make the necessary changes and click on OK to accept them or Cancel to end the operation (Fig. 6-5).
Add Intersections to a Zone using Aries
1. In the Aries Zone Manager window, right-click on the Zone 1.
2. Select Add Intersection and supply the Data Change access code. The Add Intersection Node window appears, suggesting the next available number for the intersection.
3. In the Intersection Name field, enter the name of the intersection TC1. If street names are used, normally two street names separated by an ampersand (&).
4. In the Controller Type data field, select a controller from the pulldown menu. Choices are ASC2 for the ASC/2 series, ASC for the ASC-8000 series. Press OK.
5. Depending on the type of controller selected, a controller sub type window appears prompting you to select a controller sub-type. In case of the ASC/2, this refers to NEMA TS2 type (Type 1 or Type 2) and the size of the EEPROM data module (8K or 32K). TS2 Type 2 includes TS1 emulation. In case of the ASC-8000, refers to an EEPROM version (C8000, C8001 or C8021) (Fig. 6-6).

Upload Master Data
1. In the Aries Zone Manager window, right-click on the zone 1.
2. Select Upload Master Data and press Start to begin the operation.
3. The message 'Upload Complete. SAVE, COMPARE OR CANCEL appears.
4. Select Save if this was your first upload to save the two-kilobyte file on disk. The Compare option allows you to compare the uploaded data with data from a previously saved master data file for that zone. Cancel ends the operation.

Figure 6-6 Add an Intersection
Edit Master Data

- In the Aries Zone Manager window, right-click on the Zone 1.
- Select Launch from the Menu bar and select Data Entry.
- Enter the Data Entry access code, defined earlier, to prevent unauthorized data modification. The Aries Data Entry for Zone window appears (Fig. 6-8).
- Make data change if necessary.
- Save the data and close the window.
Compare Master Data
To compare the master data in the computer and in the equipment in the field:

- From the Aries Zone Manager window, right-click on the zone.
- Select Compare Master Data, then Parameter Compare.
- In the Operation Progress Messages window, click the Start button. The Aries system compares the disk file to the uploaded file.
- The Aries Data Entry for Zone window appears and shows any discrepancy in two one-line fields at the bottom. Use the Back and Next buttons of the window to cycle between multiple discrepancy messages.

Download Master Data
1. In the Aries Zone Manager window, right-click on the zone.
2. Select Download Master Data and press Start to begin the operation. The master download operation is completed when the message ‘**** Operation Complete ****’ appears.
3. Close the window. A compare operation at this time shows the disk files and the field files match.

Upload Local Controller Data
1. In the Aries Zone Manager window, right-click on the intersection.
2. Click on Upload Local Controller Data.
3. When prompted to select the segments to upload, select only the segments that you need, a full upload from a controller through a zone master can take up to 15 minutes (Fig. 6-9).

Figure 6-9 Upload Local Controller Data
4. Press Start. When you upload controller data from an intersection for the first time, the message, Configuration does not match appears. This is normal. Choose Proceed.
5. When the upload is complete, select Save to store the uploaded data in the appropriate directory on disk.

**Edit ASC/2 Local Controller Data**

1. In the Aries Zone Manager window, right-click on the intersection and click on Controller Data Entry. Enter the Data Entry Access Code.
2. The Aries Data Entry screen appears. On the left hand side of the screen, there is a topic selection index. Clicking on each topic presents you with a different data entry sub-screens, located to the right of the index. The index tabs reflect other information topics to choose from, depending on the topic selected (Fig. 6-10).
3. Make a minor change. For instance, select By Phase Timing Data and Min Timing. Change a Minimum Green Interval by 5 second. Click on Save under the File pull-down menu.

![Image of Aries Zone Manager window](image)

**Figure 6-10 Edit ASC/2 Local Controller Data**

**Compare ASC/2 Controller Data**

To compare ASC/2 file and controller data:

1. In the Aries Zone Manager window, right-click on the intersection and click on Compare Local Controller Data. There are three options to choose from:
   - Byte Compare provides pass/fail indication by segment (or topic) by comparing the data one byte at a time.
• Quick Compare also provides pass/fail indication by segment, but in much less time by limiting the comparison to 16-bit CRC results.
• Parameter Compare identifies the specific elements that differ.

2. Select Parameter Compare. Select the segments to be compared. Selecting fewer segments saves time. Press Start to begin the upload of data from the ASC/2 controller (Fig. 6-11).

3. At the Aries Data Entry screen, the two fields at the bottom of the screen list any differences between the uploaded controller data and file data. Click on Next to move to the next difference. Click on Back to return to the previous difference.

4. Make any database changes using the Aries Data Entry screen. Select Save under the File pull-down menu to save any changes to disk. Begin a download operation to enter the file data into the ASC/2 controller.

![Figure 6-11 Compare ASC/2 Controller Data](image)

**Download Controller Data**

- In the Aries Zone Manager window, right-click on the intersection and click on Download Local Controller Data. A dialog box appears, allowing you to choose the segments to be downloaded (Fig. 6-12).
- Choose either all the segments or certain ones to download. Selecting only the segments you need to download, thus speeds up the download process and saves time.
Figure 6-12 Segments for Local Controller Data Downloading

Check the Status of the CIDs
NIATT’s controller interface devices (CIDs) should be ready for remote access through Host computer 2. However, the user needs to verify the status of the CIDs using the Hardware Tester software.

1. Click Start. Select Programs. Scroll to McCain-NIATT CID II and then CID Hardware Tester (Fig. 6-13).

![Figure 6-13 CID Software Suite Menu]

2. The right side of the CID Hardware Tester (Fig. 6-14) displays the CID identification numbers.
3. The CIDs are working properly if the ID number is displayed.
4. When the Hardware Tester indicates that everything is working properly, exit the CID Hardware Tester.
Transfer a File for Hardware-in-the-Loop Simulation

1. Click My Computer on the host computer 2 to which you will transfer your files. Your local computer’s drives will show up as network drives on the RAHILS host computer 2 (Fig. 6-15).

![Figure 6-14 CID Hardware Tester Screen](image)

![Figure 6-15 Network Drives on Remote Computer](image)
2. Click Start-Programs-PTV_Vision-VISSIM 4.0 to start VISSIM program from RAHILS host computer 2.
3. Create a new directory C:\Program Files\PTV_Vision\VISSIM400\Remote Simulation from the RAHILS host computer 2.
4. Navigate to the file or files (.inp) of interest you want to transfer using the network drives then copy to the new directory C:\Program Files\PTV_Vision\VISSIM400\Remote Simulation on RAHILS host computer 2. For example, if you want to transfer a (*.inp) file (Moscow.inp) located at C:\simulations from your local computer, then open the C on YOUR LOCAL COMPUTER drive and navigate to the simulations folder (where YOURLOCALCOMPUTER is the name of your local computer) and copy to C:\Program Files\PTV_Vision\VISSIM400\Remote Simulation on the RAHILS host computer 2.

Configure Controller Interface Device (CID)
The controller interface device is a tool that allows traffic controllers to communicate with simulations running on host computer 2. For HILS to function properly, the CID should be configured by the following steps:

1. Open the CID Configuration Tool (Usually under Start - Programs - McCain/NIATT CID II- CID Configuration Tool) from host computer 2
2. On the menu bar, select File, and Open to open the .inp Files you just transferred from your local drive to RAHILS host computer drive. For this example we have selected the file named Moscow. A graphical version of the .inp file will display onscreen showing the Signal Controlled Junctions (SCJ) and their numbers (Fig. 6-16).

![Figure 6-16 CID Configuration](image-url)
3. When you click on the node that you want to change to CID control, the CID Intersection Data dialog box will display (Fig. 6-17).

In this dialog box, complete the following tasks:

- Select the first group number. That link will be highlighted in red on the graphical display.
- In the Phase Number field, check to make sure that the correct phase number has been assigned to the selected group number. (CID hardware-in-the-loop simulation uses the NEMA phasing scheme.)
- Continue to highlight each signal group in the list and check the corresponding phase number.
- In the Controller Type field, select a controller type. If you are going to use a NEMA TS2 controller in Mode 0, and select NEMA TS1 as the controller type.
- In the Controlled By field, enter the number of the CID controlling that node, or select the CID number from the pull-down list. (The numeric display on the front panel of the CID displays that CID’s ID number.)

4. When you are finished, click OK, you will return to the graphical version of the .inp file.

5. When you have completed specifying the CID-controlled intersections with the Configuration Tool, save your work. When you click Save, the dialog will display, asking if you want to generate the CID Configuration file. Click Yes.

6. Moscow-copy1. If you do not rename the .inp file, the CID configuration file will automatically be saved with the same name as the original .inp file, and in the same directory, but with the extension .cid. When you are ready, click Save, and the configuration file will be generated (Fig. 6-18).

7. After you click Save, the dialog will alert you that the Configuration file has been created. Click OK to continue. Exit the CID Configuration Tool program.
Making Modifications to VISSIM’s .inp File within VISSIM.

Before running a real-time hardware-in-the-loop simulation with VISSIM, you will need to go into VISSIM and change some of the settings in the .inp file.

1. Open VISSIM.
2. Open the .inp file of interest. In this example we opened the copy of our .inp file that we made in the previous step, Moscow-copy1.
3. Select the Signal Control menu item and Edit Signals (Fig. 6-19).
4. The Signal Controlled Junctions (SCJ) dialog box will display (Fig. 6-20). Select the number of the intersections that is to be CID-controlled, in this example number 16. Click Edit.
5. When you click Edit, the SCJ Parameters dialog box will display (Fig. 6-21). In the Type pull-down field, select VAP. Then click the More button, to specify parameters for this intersection.

![Figure 6-21 Specify Parameters for the Intersection](image)

6. After you click the More button, the Data for VAP dialog box will display (Fig. 6-22). Click the Program File button.

![Figure 6-22 Click Program File](image)

7. When you click Program File, the Select Program File dialog box will display (Fig. 6-23). Select the folder Exe.
8. Select the file named CID, and click Open (Fig. 6-24).

9. After you click Open, the Data for VAP dialog box will display again (Fig. 6-25). The Program File field will show the application cid.exe. Now click the Logic File button.
10. When you click Logic File, the Select Import File dialog box will display (Fig. 6-26). In the File Name field, enter the same name you have given to the .inp file and CID Configuration file, with the extension .cid. For this example, we have entered the name of our sample file, Moscow-copy1.cid. Then click Open.

![Select Import File](image1)

**Figure 6-26** Enter the Same Name for the Configuration File with the Extension .cid

11. After you click Open, the Data for VAP dialog box will again display, showing the name of the file of interest, in this case Moscow-copy1.cid (Fig. 6-27). Now click the Interstages button.

![Data for VAP](image2)

**Figure 6-27** Click Interstages

12. When you click Interstages, the Select Import File dialog box will again display (Fig. 6-28). In the File Name field, again enter the same name you have given to the .inp file and CID Configuration file, with the extension .cid. For this example,
we have entered the name of our sample file, Moscow-copy1.cid. Then click Open.

![Select Import File](image1)

**Figure 6-28** Enter the Configuration File Name with the Extension .cid.

13. When you click Open, the Data for VAP dialog box will display again showing the CID Configuration file in the Interstages field (Fig. 6-29). Click OK.

![Data for VAP](image2)

**Figure 6-29** Click OK.

### Set Simulation Parameters in VISSIM

The final modification to be made in *VISSIM* before running a real-time-hardware-in-the-loop simulation is setting the simulation parameters.

1. With the .inp file of interest open, select Simulation and Parameters (Fig. 6-30).
2. When you select Parameters, the Simulation Parameters dialog box will display (Fig. 6-31). Enter the following data:
   - In the Comment field, enter the words CID real-time simulation.
   - Set the Rate of Simulation to 1.
   - Set the Time steps per Sim.sec. to 1.
   - Click OK.
3. Save your work by selecting File and Save.
Run a Real-time Hardware-In-the-Loop Simulation with VISSIM

1. Launch VISSIM if it is not already open.
2. Open the .inp file of interest, if it is not already open. In this example we opened the copy of our .inp file that we made in the previous section, Moscow-copy1.
3. With the .inp file open, select Simulation, and then Continuous.
4. The real-time simulation process will now begin (Fig. 6-32). The program searches for CID connected to the host computer, and assigns the CID to the externally controlled node that you previously selected. If the program does not find the CID, it will search again. If it still does not find the CID after a specified time period, it will abort the real-time simulation. If it does find the CID, it will continue the simulation.

Figure 6-32 VISSIM Simulation Screen

5. After the simulation is completed, you can use the VISSIM output results as you normally would.
6. If you need to transfer files from the RAHILS computer to your local computer, simply reverse the process. Drag and drop or copy and paste files from the RAHILS local drives to a location on your network drive.
CASE 7 Set Up Master-Based Coordinated Subsystems for Twenty Intersections with Aries

Programming Controller Settings
Before conducting simulations, users must program signal timing plan parameters on the remote traffic controllers. Using the Controller Interface Network (CIN) device, users will run traffic management software for each of the controllers in the bank they are using.

The Controller Interface Network (CIN) device is a COM (RS232) port switch box that allows Host computer 1 to connect to the traffic controllers in the lab.

1. Run the Remote Desktop Connection to connect to host computer 1, which runs traffic management software.
2. From the Start menu of the host computer 1, select Programs; scroll to Controller Interconnection Network and release the mouse (Fig. 7-1).

![Figure 7-1 Controller Interconnection Network Menu](image)

3. In the COM Port Configuration for Controller Interconnection Network dialog box, select the one you are using and click Proceed (Fig. 7-2).

![Figure 7-2 COM Port Selection](image)

4. Categorize 20 intersections into four subsystems, which are represented by four banks, respectively. For subsystem Bank 1 in the Controller Interconnection Network GUI a Setup button appears above the image of each controller. Press Setup for Traffic Controller 1. The line between the host computer and traffic controller will change from dashes to a solid green line, indicating that the controller is connected to the host computer for Setup (Fig. 7-3).
5. Once the controller has been programmed, the Setup button will read Done. Click Done.
6. Repeat steps 4-5 to program Traffic Controller 2, 3, 4 and 5.
7. Master controller should be set up for Master-Based Coordination. In the Controller Interconnection Network GUI, a Setup button appears below the image of master traffic controller. Press Setup for master traffic controller, the line between the host computer and master traffic controller will change from dashes to a solid green line, indicating that the master traffic controller is connected to the host computer (Fig. 7-4).

8. Repeat steps 4, 5 and 7 to configure subsystems Banks 2, 3 and 4. The entire Controller Interconnection Network GUI is shown in Fig. 7-5.
Bank 1 has a master based network with traffic controller 1, 3, and 5 connected to the master. Bank 2 is in isolated configuration. Notice that even though traffic controllers 1 and 3 are connected to the internal bus, they are still independent since the master is not connected to the internal bus. In this bank, traffic controller 2 is connected to the laptop for Setup and so is the master. Also notice that that SETUP buttons for all other controllers and masters are disabled. The master controller of Bank 4 is controlling traffic controllers 1, 2 and 5 of the same bank and traffic controllers 1, 2, 3 and 5 of Bank 3. So the master in Bank 4 is controlling a total of 7 controllers.

It is easy to connect/disconnect the traffic controller to/from the master controller by clicking Connect to Master or Disconnect from Master. By clicking Connect to Bus/Disconnect from Bus, it can connect/disconnect all controllers within a bank to/from master controller. It is convenient to connect/ disconnect master controller to/from master network Bus by clicking Connect to Master Bus/Disconnect from Master Bus.

**Figure 7-5 Entire Controller Interconnection Network GUI**

**Adding New Zones (subsystem Banks) Using Aries**

1. In the Aries Zone Manager window, right click Zones and select Add Zone. Add Zone Node window appears.
2. The window defaults to the next unused zone number, which you may overwrite as necessary.
3. Enter the Telephone Number if the zone is connected via a modem. Add any applicable dialing prefixes or long distance codes. Insert spaces, hyphens and parentheses. Insert a comma for a dialing pause or leave blank in case of direct connect.

4. Enter Bank 1 in the Zone Name. This also can be the name of the street for an arterial with multiple intersections.

5. Click in the field for Zone Type and make a selection from the pull-down menu.

6. Click on the field for Bit Rate and make a selection from the pull-down menu. The normal choice should be 2400 bps. Use 1200 bps or 300 bps for older, slower modems in the field. This does not apply to Intersection Monitor II, ASC-8000 or ASC/2 direct zones.

7. Enter the Access Code for any Zone Master where an access code is required for security purposes.

8. Check the box Create New Master Data File to create a data file for that zone on the Aries computer.

9. Click OK. The Data Rate Selection window appears. Enter the same bit rate as entered previously, typically 2400 or 1200 bps.

10. Click OK to complete data entry for the first zone Bank 1 (Fig. 7-6).

11. Repeat steps 1-10 to create Zone 2, 3 and 4 for subsystem Banks 2, 3 and 4.

Figure 7-6 Create Zones

Editing a Previously Entered Zone
1. Select the Aries Zone Manager window.
2. Right-click Zone 1 and select Edit Zone Properties from the pull-down menu.
3. The Edit Zone Node window appears. Make the necessary changes and click OK to accept them or Cancel to end the operation (Fig. 7-7).
4. Repeat steps 2-3 to edit other zones if necessary.

**Adding Intersections to a Zone**

1. In the Aries Zone Manager window, right-click the Zone 1.
2. Select Add Intersection and supply the data change Access Code. The Add Intersection Node window appears, suggesting the next available number for the intersection.
3. In the Intersection Name field, enter TC1. If street names are used, normally two street names separated by an ampersand (&).
4. In the Controller Type data field, select a controller from the pull-down menu. Choices are ASC2 for the ASC/2 series, ASC for the ASC-8000 series. Press OK.
5. Depending on the type of controller selected, a controller sub type window appears prompting you to select a controller sub-type. In case of the ASC/2, this refers to NEMA TS2 type (Type 1 or Type 2) and the size of the EEPROM data module (8K or 32K). TS2 Type 2 includes TS1 emulation (Fig. 7-17).
6. Repeat steps 1-5 above to add other intersections to Zone 1 and Zone 2-4 (Fig. 7-8).
Setting up Communication

1. In Aries Zone Manager, click Launch, then Communication Server. The Aries Communications Server window appears (Fig. 7-10).
2. In Aries Communications Server, click File, then select Setup, next select Channel. The Channel Configuration window appears (Fig. 7-11).
3. If there is no existing channel, click Insert to add a new one. If a channel already existed, click Properties to edit.
4. In Channel 1 Configuration, click Port.

Figure 7-10 Open Aries Communications Server

Figure 7-11 Channel Configuration

5. For Port Number, enter the number corresponds to serial port on the computer.
6. For Bite Rate, select 19,200 for direct connection.
7. For Data Bits, check the box for 7.
8. For Parity, check the box for Even.
9. For Stop Bits, check the box for 1.
10. In Channel 1 Configuration, click Options in the menu.
11. For Communication Type, select Direct.
12. For Inactivity Period, input 1.
13. For Mode, select Any.
14. Check the box for Zone Number Verification.
15. Click Apply, and then click OK to dismiss Channel 1 Configuration (Fig. 7-12).

![Channel 1 Configuration](image)

**Figure 7-12 Channel 1 Configuration**

**Verifying Communication**

To verify the communication for the Master and each local controller:

1. In Aries Zone Manager, right-click Bank 1 and then select Compare Master Data. Next select Byte Compare.
2. Operation Progress Messages window appears. Click Start to conduct Byte Compare for Zone 1.
3. Repeat steps 1-2 to verify communication for Bank 2, 3 and 4 (Fig. 7-13).
4. In Aries Zone Manager, right-click TC1 under Bank 1, then select Compare Local Controller Data, and next select Quick Compare.
5. Operation Progress Messages window appears. Click Start to conduct Quick Compare for Zone 1, Intersection 1.
6. Repeat steps 4-5 to verify communication for other local controllers (Fig. 7-14).
Uploading Master Data

To upload master data:

1. In the Aries Zone Manager window, right-click the desired zone.
2. Select Upload Master Data and press Start to begin the operation.
3. The message Upload Complete. SAVE, COMPARE OR CANCEL appears.
4. Select Save if this was your first upload to save the two-kilobyte file on disk. The Compare option allows you to compare the uploaded data with data from a previously saved master data file for that zone. Cancel ends the operation (Fig. 7-15).

![Figure 7-15 Upload Master Data](image)

**Editing Master Data**

To edit the master data that you have uploaded:

1. In the Aries Zone Manager window, right-click on the desired zone.
2. Then select Master Data Entry.
3. Enter the Data Entry access code, defined earlier, to prevent unauthorized data modification. The Aries Data Entry window appears.
4. In Aries Data Entry window, click on the topic selection index on the left side of the window, and then make data change if necessary. Below are two sample topics with different data entry sub-screens.
   
   a. In Aries Data Entry-Bank 1, click System Parameters. On the right of the index, a set of data entries of General, SD diagnostics, Nominal Speed, and Version appears.
   
   General.
   
   Master Number: enter the corresponding number for Master.
   
   Cycle length Cycle X: Local controller coordination plans are entered here. If four coordination plans are being used, the first four entries need to be modified, so that the local controllers can be coordinated (Fig. 7-16).
Figure 7-16 Editing System Parameters for Master

b. In Aries Data Entry-Bank, click TOD Weekly/Yearly. On the right of the index, a set of data entries of Week l and Yearly appears.

Weekly. TOD can be programmed on a certain day of the week. For example, program 1 runs Monday through Friday and program 2 runs on Saturday and Sunday (Fig. 7-17).

Yearly. TOD can be programmed based on a certain week of year (Fig. 7-18).

5. Make data change for other topics index if necessary. Save the data and close the window.
Comparing Master Data
To compare the master data in the computer and in the equipment in the field:
1. From the Aries Zone Manager window, right-click the Zone.
2. Select Compare Master Data, then Parameter Compare.
3. In the Operation Progress Messages window, click the Start button. The Aries system compares the disk file to the uploaded file.
4. The Aries Data Entry for Zone window appears and shows any discrepancy in two one-line fields at the bottom. Use the Back and Next buttons of the window to cycle between multiple discrepancy messages (Fig. 7-19).

![Figure 7-19 Comparing Master Data](image)

**Figure 7-19 Comparing Master Data**

**Downloading Master Data**

To download the edited master data:

1. In the Aries Zone Manager window, right-click the desired Zone.
2. Select Download Master Data and press Start to begin the operation. The master download operation is completed when the message **** Operation Complete **** appears.
3. Close the window. A compare operation at this time shows the disk files and the field files match (Fig. 7-20).
To upload controller data:

1. In the Aries Zone Manager window, right-click the desired intersection.
2. Click Upload Local Controller Data.
3. When prompted to select the segments to upload, select only the segments that you need, a full upload from a controller through a zone master can take up to 15 minutes.
4. Press Start. When you upload controller data from an intersection for the first time, the message, Configuration does not match appears. This is normal. Choose Proceed.
5. When the upload is complete, select Save to store the uploaded data in the appropriate directory on disk (Fig. 7-21).
To edit ASC/2 controller data:

1. In the Aries Zone Manager window, right-click the intersection and click Controller Data Entry. Enter the Data Entry Access Code.

2. The Aries Data Entry screen appears. On the left hand side of the screen, there is a topic selection index. Clicking on each topic presents you with a different data entry sub-screens, located to the right of the inde. (Fig. 7-22).
Below are two sample topics with different data entry sub-screens

a. Configuration. In Aries Data Entry window, click Configuration, on the right of the index, a set of data entries of Seq., In Use, LS Assign, SDLC, Port 2, Port 3, Logging, Access, MMU, and Vision appears.

Seq.

- Select ring phase assignment, order of rotation, and concurrent group barrier position to define controller phase sequence (Fig. 7-23).
In Use
• Indicates phases including overlaps to be active and define the direction for each phase. Exclusive Ped means phases timing only pedestrian intervals without concurrent vehicle movement (Fig. 7-24).

Figure 7-24 Editing In Use of Configuration for Local Controller

• LA Assign
Assigns phase 1-12 and overlap A-D to MMU channels and load switch 1-16. Number 13, 14, 15, and 16 correspond to overlaps A, B, C, and D, respectively. Pedestrian phases must be identified (Fig. 7-25).

Figure 7-25 Editing LS Assign of Configuration for Local Controller
- SDLC
  Enable BIU used by terminals and facilities.
  Enable BIUs used by detector rack by all detector interface functions.
  Enable Type 2 controller to operate as Type 1.
  Disable MMU readback capabilities for Type 2 operation.
  Enable interface to test case for bench top diagnostics.
  Enable peer to peer communication, this enables communications between devices external to traffic control system via the controller.
  Define peer to peer device address, communications addresses can be set for up to ten external devices attached to SDLC (Fig. 7-26).

![Figure 7-26 Editing SDLC of Configuration for Local Controller](image)

- Port 2
  Toggles Terminal for Port 2 Protocol
  Select terminal data rate (1200, 2400, 4800, 9600, or 19.2k).
  Specify word length, parity and stop bit (7, E, 1 or 8, N, 1).
  Define AB3418 protocol parameters.
  Enable port 2(Fig. 7-27).
Figure 7-27 Editing Port 2 of Configuration for Local Controller

- Port 3
  - Assign telemetry address to local controllers (1-5).
  - Assign a unique address number 1-24 to groups of local system detectors to allow a zone master to access system detectors 9-16 as defined by the controller.
  - Set a telemetry response delay.
  - Define AB3418 Address (0-65535).
  - Define AB 3418 Group Address (0-65535 except 63).
  - Define AB3418 Response Delay (0-71 msec).
  - Define AB3418 Drop-Out Time (0-64800 sec).
  - Define Data, Parity, Stop (8, 0, 1; 8, N, 1; 8, E, 1; 7, E, 1).
  - Enable port 3 (Fig. 7-28).
Logging. Enable real-time logging of various events (Fig. 7-29).

Coordination Patterns. In Aries Data Entry, click Coordination Patterns. Patterns can be selected from 1-64.
• Cycle length (30-255 seconds).
• COS (Cycle/Offset/Split) is another way of referring to the coordination plan. Three plans with different cycle lengths, offsets, and splits can be expressed as 1/1/1, 2/2/2, and 3/3/3.
• Offset is typically entered in seconds.
• Splits are entered in percentages or in seconds.
• Coordinated Phases are usually the main street through phases.
• Vehicle Max Recall is enabled on all phases that have no detection (Fig. 7-30).

![Figure 7-30 Editing Coordination Patterns for Local Controller](image)

Make data change for other topics index if necessary. Click Save Data File under the File pull-down menu.

**Comparing ASC/2 Local Controller Data**

To compare ASC/2 file and local controller data:

1. In the Aries Zone Manager window, right-click the desired intersection and click on Compare Local Controller Data. There are three options to choose from:
   - Byte Compare provides pass/fail indication by segment (or topic) by comparing the data one byte at a time.
   - Quick Compare also provides pass/fail indication by segment, but in much less time by limiting the comparison to 16-bit CRC results.
   - Parameter Compare identifies the specific elements that differ.
2. Select Parameter Compare. Select the segments to be compared. Selecting fewer segments saves time. Press Start to begin the upload of data from the ASC/2 controller.

3. At the Aries Data Entry screen, the two fields at the bottom of the screen list any differences between the uploaded controller data and file data. Click Next to move to the next difference. Click Back to return to the previous difference.

4. Make any database changes using the Aries Data Entry screen. Select Save under the File pull-down menu to save any changes to disk. Begin a download operation to enter the file data into the ASC/2 controller (Fig.7-31).

**Figure 7-31 Comparing Local Controller Data**

**Downloading Local Controller Data**

To download controller data:

1. In the Aries Zone Manager window, right-click the desired intersection and click Download Local Controller Data. A dialog box appears, allowing you to choose the segments to be downloaded.
2. Choose either all the segments or certain ones to download. Select only the segments you need to download, thus speeds up the download process and saves time (Fig. 7-32).

Figure 7-32 Downloading Local Controller Data